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Overview
ClipMate™ is designed to enhance the native capability of the Windows clipboard.    From a functional 
standpoint, the Windows Clipboard works exactly as it should: allowing the user to transfer an item of data
within an application, or between applications.      In practice, however, the Clipboard falls short because it 
can only hold one item of data at a time.    Multiple formats yes, but still the same item of data.    When you
perform a CUT or PASTE, the clipboard is emptied, and your new piece of data is now the sole occupant 
of the clipboard.    There is no ability to append new data onto the existing clipboard data, no UNDO 
capability, and no long-term memory.    That's where ClipMate steps in!

ClipMate adds several value-added enhancements to the operation of the Windows Clipboard.    It allows 
you to keep hundreds of previous Clipboard occupants, (Clip Items) for later retrieval.    If there is a 
particular piece of data that you use often, it can be stored indefinitely in ClipMate's SAFE LIST.    There 
are many editing functions available for textual data, such as reformatting paragraphs, and gluing data 
together.

ClipMate also allows you to collect non-textual data formats, such as BITMAP, PICTURE, RTF, and OLE 
objects.    The PowerPaste™ feature allows you to paste data into your applications quickly and easily.    
Once activated, ClipMate enters a kind of "auto pilot", sensing when you've pasted data, and 
automatically advancing to the next clip item for you.

Related Topics:
A New Paradigm For Data Exchange
What About The New ClipBook In NT/WFW?
Here's how ClipMate operates



A New Paradigm For Data Exchange
ClipMate will change the way that you think of data exchange within Windows.    

Using the native Windows clipboard is like a bizarre shopping experience, in a store where you can carry 
only one item at a time.    If you see something that you'd like to purchase, you must drop anything else 
that you might be carrying!    The only way to keep anything is to leave the store, take your item home, 
and then come back for more.    The native Windows clipboard works much the same way.    It will only 
hold one item at a time, forcing you to switch applications, paste, and then come back for more.    
Obviously, this is not very productive!

With ClipMate, you have the freedom to gather all of your data, edit and manipulate it in several ways, 
and easily paste it into your applications.    Think of ClipMate as a super shopping cart.

ClipMate lets you combine multiple clipboard items into larger ones, edit the clipboard directly, save data 
for long-term use, and even give names to clip items.    ClipMate has a safe list where you can 
permanently store commonly-used items, such as your return address, directions to your office, favorite 
quotations, even a scanned/faxed bitmap of your signature!    

Aside from being a super clipboard-collector, ClipMate has features to save you time when pasting your 
data into other applications.    First of all, whenever you select an item within ClipMate, it is 
AUTOMATICALLY copied to the clipboard, ready to paste into any application that can use it.    If you have
several text items to paste, you can glue them together, into one large item - so that you only have to 
paste once.    But the ultimate paste experience comes from ClipMate's exclusive PowerPaste function.    
Once enabled, you can go to an application, and paste one item after another.    No stopping to re-select 
within ClipMate!    PowerPaste will keep updating the clipboard with the next item in the list, and you just 
keep pasting.



What About The New ClipBook In NT/WFW?
Maybe you've seen the ClipBook application that comes with Windows NT, and Windows for Workgroups. 
This is an improvement over the old clipboard, but it is still far from ideal.    It is like having a shopping 
cart, but being forced to pay for each item before you can put it in the cart!    You see, Microsoft's ClipBook
doesn't capture data automatically.    Nor does it have any of the cool ClipMate features, such as Glue, 
PowerPaste, or Print.    

ClipMate is the only clipboard utility that filters-out unwanted data formats (See Application Profile).    Most
of today's applications, especially those that use OLE, can provide data in a variety of formats (Excel 5.0 
provides 21 separate formats).    You don't want them all!    Imagine ordering Swiss cheese from the deli 
counter, and being told that Swiss cheese isn't sold separately - you need to purchase all varieties of 
Cheese, or none at all!        ClipMate is the only clipboard utility that lets you specify which data 
formats you will work with.    



Here's how ClipMate operates
ClipMate sits idle most of the time, waiting for any activity in the Windows Clipboard.    Whenever you put 
anything on the Clipboard (by CUTting or COPYing), ClipMate is notified.    ClipMate checks to see if the 
Clipboard contains data in any desirable formats (formats that YOU want to capture).    If there is, 
ClipMate automatically makes of copy of the data for itself.    It stores the data, creates a title, and displays
the title in the text window at the top of the Clip Item Selection List Box.    If the Magnification Window is 
active, the new Clip Item is displayed within it. 

Access to the data is easily obtained through the use of a drop-down list, or a graphical grid, showing 
ThumbNail sketches.    As you make a selection, ClipMate automatically copies that item to the 
clipboard.    It is then ready for your use in any application that offers clipboard support for the data 
formats contained within the item.

Note: It is generally advisable to have ClipMate running all of the time, as it can't capture data if it isn't 
running.    ClipMate will continue to capture data, even if run as an Icon.    We suggest placing ClipMate in 
your STARTUP group, so that it is always active.



Features new to version 3.0
ClipMate 3.0 has many enhancements that can help make you more productive than ever before!    
Anyone who has used ClipMate 2.0 will appreciate the completely-redesigned FILTER facility, now known
as Application Profile.    There are also several features that make ClipMate more useful when run as an 
Icon, such as "Sticky Icon", "Icon Title", and "Control Menu".    There is even a feature to indent/un-indent 
blocks of text.

The new features are listed below, and are explained in greater detail later on.    In case you haven't used 
the previous 2.0 release, be sure to review the section titled Other Features.

Application Profile - The Improved FILTER facility
Previously known as FILTER, this feature has been completely re-designed to make it more user-friendly. 
In most cases, it will determine the correct settings, with no user intervention.

The Application Profile instructs ClipMate to collect only the data formats that YOU wish to work with, and 
discard the rest.    For example, Microsoft's Word for Windows 6.0 provides clipboard data in 8 different 
formats - most of which are redundant, and are provided for OLE purposes, or for compatibility with 
applications that you may never use!    Without a way to omit the formats that you don't need, you would 
quickly be buried by data, and no matter how fast your processor is, you would experience dramatic 
slowdowns when copying data.    

ClipMate's Application Profile is smart enough to pick and choose the data that you want, leaving the rest 
behind.    This greatly speeds the copying process, and reduces the amount of memory and resources 
consumed.    Furthermore, ClipMate 3.0 uses a "stealth" technology, which in most cases, will build the 
Application Profile with no intervention needed on your part.    It is easy for you to override the default 
decisions, if you need to.    See: Application Profile.

Support For 16-Bit Bitmaps
Video drivers that support 65,000 simultaneous colors are now supported, along with 24-bit drivers, 
supporting 16 million colors.

Sticky Icon
ClipMate now features the ability to lock the icon position, so that whenever it is minimized to an icon, the 
icon will always be in the same place.    It "sticks", so to speak.    Quickly toggle this feature from the 
CONFIG menu, or the CONTROL menu.    See: Lock Icon Position.

Icon Title
ClipMate now has the ability to use the title of the current Clip Item as the title shown under the Icon when
it is iconified.    Toggle this option in the User Preferences dialog, found under the CONFIG menu.    See: 
User Preference Dialog Box.

Control Menu
Many of the options listed under the various menu headings have been duplicated in the CONTROL 
menu, also known as the SYSTEM menu.    This is the menu that shows when you click on a running icon,
or on the square button on the upper-left of most apps.    

The significance of this menu is that you can get to most features while ClipMate is iconified, running in 
Brief View, or if you turn off the main menu.    Used in conjunction with the Icon Title, ClipMate is quite 



usable in the iconified state.    See: Control Menu.

Main Menu Is Optional
If you don't need the main menu, turn it off.    You can still access many options from the Control Menu.    
Toggle this option in the User Preferences dialog, found under the CONFIG menu.

Auto Capture Can Be Disabled
If you don't want ClipMate to capture data, you can easily make it ignore new clipboard data.    Just toggle
the state with this new menu option, found in the CONFIG menu.    See: Auto Capture.

Select Next/Prev Item From Menu
Instead of selecting an item from the drop-down list, ThumbNail View, or Magnify, you can use the "Select
Previous Item" or "Select Next Item" menu options, found under the View menu.    As long as the ClipMate
window has focus, you can use the Ctrl+P and Ctrl+N hotkeys, respectively.    See: Select 
Previous/Next.

Flow Paragraph
This feature has now been brought out to the Edit menu, for convenience.    It still resides in the 
Magnification Window, as well.    

Magnification Window
The << and >> buttons will shift a block of text to the left, or to the right, respectively.    Programmers, and 
users of 3270 Emulators, will appreciate this feature, as it lets you indent blocks of text easily, when the 
editor at hand just won't do it.    See: SHIFT TEXT << >>.



Other Features
This section covers the highlights of ClipMate 2.0, in case you haven't used that version.

Support for Graphics, and other Large Data types
ClipMate supports non-textual data types, such as BITMAP, PICTURE, RTF, and even OLE objects.    
ClipMate's advanced memory management and filtration facilities allow you to collect these large data 
types without draining your system memory and resources.

For more information see: Clipboard Formats.

PowerPaste
ClipMate has always had the ability to automatically collect data in the background, as you work within 
your application.    PowerPaste lets you use your data just as easily.    Simply turn PowerPaste on, go to 
your application, and start pasting.    When ClipMate detects that you've pasted data, it automatically 
advances to the next clip item.    Paste again, and you get the second item of data.    Paste once more, 
and you get the third item.    You have the option of working your way up the clip list (toward newer data) 
or down the clip list (toward older data).    

This feature is particularly powerful when working with applications that won't accept Glued data, such as 
an order-entry screen.    

See: PowerPaste™.

Load On Demand
Large data types such as BITMAP, PICTURE, RTF, and OLE, require a lot of memory.    ClipMate normally
stores these large items on disk, until needed.    When you access a Clip Item, ClipMate checks to see if it
is in memory, or on disk.    If it is on disk, it automatically re-loads the item for you.    

See: Memory Management with "Load On Demand".

ThumbNail View
Using the ThumbNail View Window, you can see a grid of ThumbNail sketches of BITMAPs, PICTUREs, 
or even text.    The grid is configurable to display images in a grid ranging from 2x2 to 8x8, with an option 
to show graphics, text, or both.    When viewing thumbnails of text items, you can use a very small font, so
that you can visually select text items by their appearance.

See: Visual Selection by ThumbNail.

Drag and Drop
You can use the File Manager to drag and drop BITMAP files (.BMP) onto ClipMate.    They will then be 
available to paste into other applications, without the work of copying them from another application, such
as Paintbrush.    They behave like regular clip items, except that the actual .BMP files will NOT be deleted 
from the disk by ClipMate when the clip item is deleted from ClipMate, or during the normal purge process
of the recyclable list.



Purchasing a Registered Version of ClipMate
During your evaluation of ClipMate, you have been using a SHAREWARE or "evaluation" copy of 
ClipMate.    You are entitled to use ClipMate for 30 days, for the purpose of evaluation.    After this time you
are required to purchase a Registered Copy.    If you feel that ClipMate doesn't meet your needs, or for 
any reason you decide that you don't want to purchase a registered copy, you are required to delete the 
program from your computer.    This is the ultimate "Try Before You Buy" marketing strategy.    For more 
information on this marketing principle, See: Shareware Marketing - What is it?.

Purchasing your registered copy of ClipMate entitles you to continue using the product, and gives you 
specific benefits, such as a printed manual, the latest version on diskette, and access to technical 
support.    Also, the (somewhat annoying) Registration Reminder screens will be removed!    For more 
information on benefits of registration, See: Registration Benefits:.

NOTICE: Continued use of the unregistered version of ClipMate past the 30 day evaluation period is a 
violation of federal copyright laws.

See Also:
Pricing
Registration Benefits:
BONUS for Registered Users!
Placing Your Order
Upgrading From A Previous Version Of ClipMate



Pricing
The registration fee for ClipMate, if purchased directly from Thornton Software Solutions,    is $25.00 in 
U.S. funds.    

Upgrades from previous versions are available!    See: Upgrading From A Previous Version Of ClipMate.

Shipping in North America is free.

Outside of North America, Add    $2.00 for overseas shipping & handling.    (Airmail is standard service)

Multi-User and Site License pricing is available.    See: SITELIC.TXT for details.



Registration Benefits:
By registering ClipMate, you gain the following:

1. A new diskette - We will send you the latest and greatest release of ClipMate, on you choice of 
either a 3.5" (the default), or 5.25" diskette.      

2. A printed Manual.

3. A registration number - which will remove the annoying "SHAREWARE NOTICE" reminder 
screens. 

4. Peace of mind - you have fulfilled your obligation, and have made the Shareware concept work.    
You are not breaking the law, at least in this particular case!

5. Access to support - If you have problems using ClipMate, we are here to help you.    Support is 
guaranteed for 90 days from the date of registration.    If we can't resolve your problem to our 
mutual satisfaction, we will refund your money, as long as the problem is brought to our attention 
within the 90 day window.

See Also:
BONUS for Registered Users!



BONUS for Registered Users!
To fill the otherwise empty remaining space on your registered diskette, we have put together a collection 
of excellent shareware utilities by other authors.    If you like ClipMate, then you may also like Fast-Paste 
by Robert Nee, BarClock by Atomic Dog Software, and Bob's CD Player by Robert Hayes (Bob).    The 
selections change often, as we find new programs, and as disk space dictates.    Be assured, however, 
that we will fill the remaining space with high-quality shareware - yours to evaluate, under normal 
shareware terms.

One program that we know for sure will be there is FAST-PASTE by Robert F. Nee.    Fast-Paste is a utility
that allows easy access to the clipboard for DOS applications running in a Window.    Instead of having to 
use the window's control bar to EDIT | MARK, EDIT | COPY, you just use the left mouse button to 
highlight data.    Release, and it is copied to the clipboard (and ClipMate).    Click with the right mouse 
button, and it pastes.    This is a big time saver to anyone working with windowed DOS applications, and is
a natural complement to ClipMate.    At Thornton Software Solutions, we use it every day!



Placing Your Order
Ordering Directly From Thornton Software Solutions
Ordering Through CompuServe
Egghead and Other Resellers
Local Registrations In Other Countries



Ordering Directly From Thornton Software Solutions
We can take Personal Checks, Money Orders, VISA, Mastercard, and even Cash.    Purchase Orders are 
also acceptable.    You can find an order form in either of the two files: 

· CLMREG.TXT for single-user licenses.

· SITELIC.TXT for multi-user and site licenses - recommended if you need 5 or more copies.

We recommend that you select one of these forms, edit it electronically, print it, and mail, FAX, or Email it 
to Thornton Software Solutions.    Additionally, you can phone us with a credit card number, at (716) 227-
6505.

TIP For Editing Order Form:    Notepad works well, if you're going to Email it.    Otherwise, use Write, or 
import into your favorite word processor.    

See Contacting Thornton Software.
For Registration Benefits, Pricing, Etc, See: Purchasing a Registered Version of ClipMate.

Related Topics:
Foreign Registrations?



Foreign Registrations?
If you are outside of the U.S., and are unable to send a check drawn on a U.S. Bank,    and don't have a 
Visa/Mastercard, then try a postal money order.    Another alternative is to send cash.    Our mail orders go
to a Post Office Box, and we have never had a problem with cash getting "lost" in the mail.    Under no 
condition should you send a check drawn on a non-U.S. bank.    Our bank will not process foreign checks,
and therefore we will not process orders with payment by a foreign check!

See Local Registrations In Other Countries.



Ordering Through CompuServe
Through an arrangement with CompuServe, you may order a registered copy of ClipMate, and charge it 
to your CompuServe account.    This is different than sending us a creditcard order to our CompuServe 
account, which you can also do.

ORDERING:

Sign-on to CompuServe, and GO SWREG    (Shareware Registration) .

Select Register Shareware from the main SWREG Menu.

Select Registration ID from the SEARCH BY menu.

Enter 173 as the ID.

ClipMate's description should be on the screen.    Enter Y to register.

See alternative methods of Ordering:
Ordering Directly From Thornton Software Solutions.

Local Registrations In Other Countries



Egghead and Other Resellers
We realize that many companies only purchase software through particular channels, or may have 
formed alliances with large resellers such as Egghead Software.    This often makes it difficult to order the 
software that you need (like ClipMate).    

Good News!    You can purchase ClipMate as a special order through Egghead Software.    

Egghead SKU: 913038        ClipMate for Windows.

Contact Egghead for pricing.

The package that you receive will contain a registration card, which you must complete and return.    This 
will add you to our customer database, which will qualify you for technical support upgrade notices.

If you need to purchase from another reseller, just give them a copy of our order form, (CLMREG.TXT) 
and have them contact us.    See: Contacting Thornton Software.

Note: Orders placed with resellers may add a week or so to the normal delivery time.



Local Registrations In Other Countries
We have made arrangements with dealers in several other countries to accept payment locally, for fully 
registered versions (no upgrades).    Contact one of these dealers for local pricing and other benefits, 
such as manual translations or language-specific versions of ClipMate.    Prices and services vary by 
dealer, and will evolve over time.

Related Topics:
GERMANY (Deutschland) - Local Registration
FRANCE - Local Registration
Japan - Local Registration



GERMANY (Deutschland) - Local Registration
You can contact this German company, which can accept registrations in DM.    Just fill-out CLMREG.TXT,
include a check (DM) or credit card info, and send to DER PD-PROFI.

DER PD-PROFI Gerd Zoettlein
Schulstr. 13
D-86666 Burgheim
Tel. 08243-1296
Fax. 08243-8674
CIS. 100326,53
Preis DM 54.-- plus Registriergebuehr DM 25.-- plus Versand
Zahlung per NN, Vorkasse, Kreditkarte



FRANCE - Local Registration
We have an agreement with WINDOWSHARE SARL to take orders for us in all of French-Speaking 
Europe.    You have the choice of dealing with WindowShare, or directly with Thornton Software Solutions. 
The advantage of WindowShare, is that they can accept payment in Francs.

To order from Windowshare, just print the French Order Form from this help file, complete, and submit to 
Windowshare.

French Order Form (WindowShare)
Bon de Commande Français

ClipMate for Windows 3.0    LICENCE d'UTILISATION

(Les sociétés peuvent nous consulter pour des licences multipostes 

ou des licences multiples)

Remplacez le soulignement par les renseignements demandés. 

Imprimez cette fiche, et adressez le tout avec votre règlement 

de 270 FF TTC (pour chaque poste), TVA (18,6 %)

et port compris à :
WindowShare SARL
B.P. 2078
57051-METZ cedex 2
France
Fax:(+33)87 32 37 75
Vox:(+33)87 30 85 57
Minitel 3615 WinShare

Nom et Prénom : ____________________________________________________

Adresse : ____________________________________________

____________________________________________________

Code Postal et Ville : ____________________________________________________

Nombre de licences : __________________ 

Date ______________________ 

Disquette : ___ 3 1/2" ___ 5 1/4"

Total TTC ________

Paiement par chèque (bancaire ou postal), Eurochèque, mandat-lettre, ou carte bancaire.    (barrer la 
mention inutile)

Carte bancaire, indiquez ici les 16 chiffres et la date d'expiration.

_____________________________________        Exp. : _______

Signature :

Merci de respecter le principe du shareware.



Japan - Local Registration
This program can be registered locally in Japan. For details, contact:

P. & A. Shareware Distribution.
302 Bellwins, 1367-23
Nakagami, Akishima
Tokyo, 196    Japan
Tel: 0425-46-9141
Fax: 0425-46-9142
NIFTY-Serve: PAF02461

Let them know that you are interested in purchasing a registered version of ClipMate 3.0.



Upgrading From A Previous Version Of ClipMate
If you are a registered user of a previous version of ClipMate, there is an attractive upgrade path 
available.    By upgrading, you will receive a new diskette, manual, and registration number for ClipMate 
3.0.      Upgrade Pricing is as follows:

Single-User From 1.x: $15.00 U.S.
Single-User From 2.x $10.00 U.S.
Multi-User License $25.00 U.S.
(From 1.x or 2.x): 
(Covers All Copies, Regardless of license size!)

Use the order form in CLMREG.TXT.    Be sure to include your registration number, to qualify for the 
upgrade offer.
CompuServe Users:
If you are on CompuServe, you can use the SWREG service to upgrade.    Follow the instructions in , but 
substiute the following product: 

Program Title: CLIPMATE 3.0 UPGRADE
Registration ID: 1120

Note: When you install ClipMate 3.0 on top of a previous release, you will be granted a 60-day grace 
period, during which time the dreaded "Registration Reminder" screen will not appear.    This extra time is 
provided as a courtesy to our current customers.



Copyright
Copyright Ó 1991-1994 Thornton Software Solutions

All rights reserved.

Any use of the unregistered version of ClipMate past the 30-day evaluation period is prohibited, and a 
violation of the copyright.

For license, warranty, and disclaimer, see: VENDINFO.DIZ



Shareware Marketing - What is it?
DEFINITION OF SHAREWARE - Provided by the Association of Shareware Professionals (ASP)

Shareware distribution gives users a chance to try software before buying it. If you try a Shareware 
program and continue using it, you are expected to register. Individual programs differ on details -- some 
request registration while others require it, some specify a maximum trial period. With registration, you get
anything from the simple right to continue using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all 
rights, with a few specific exceptions as stated below. Shareware authors are accomplished 
programmers, just like commercial authors, and the programs are of comparable quality. (In both cases, 
there are good programs and bad ones!) The main difference is in the method of distribution. With 
shareware, the author specifically grants the right to copy and distribute the software, either to all and 
sundry or to a specific group. For example, some authors require written permission before a commercial 
disk vendor may copy their Shareware.

Shareware is a distribution method, not a type of software. You should find software that suits your needs 
and pocketbook, whether it's commercial or Shareware. The Shareware system makes fitting your needs 
easier, because you can try before you buy.    And because the overhead is low, prices are low also. 
Shareware has the ultimate money-back guarantee -- if a program doesn't meet your needs, you don't 
pay for it.

ClipMate is a "shareware program" and is provided at no charge to the user for evaluation.    Feel free to 
share it with your friends, but please do not give it away altered or as part of another system.    The 
essence of "user-supported" software is to provide personal computer users with quality software without 
high prices, and yet to provide incentive for programmers to continue to develop new products.    If you 
find this program useful and find that you are using ClipMate and continue to use ClipMate after a 
reasonable trial period (30 days), you must make a registration payment of $25.00 to the author. 

Site License arrangements are available.

Anyone distributing ClipMate for any kind of remuneration must first contact the author for authorization.    
This authorization will be automatically granted to distributors recognized by the Association of Shareware
Professionals (ASP) as adhering to its guidelines for shareware distributors, and such distributors may 
begin offering ClipMate immediately (However the author must still be advised so that the distributor can 
be kept up-to-date with the latest version of ClipMate).

You are encouraged to pass a copy of ClipMate along to your friends for evaluation.    Please encourage 
them to register their copy if they find that they can use it.    No one may distribute a partial or altered copy
of ClipMate.    Because the registration information is stored in the ClipMate.INI file, this file MUST NOT 
BE DISTRIBUTED.    If you don't have a complete copy, you should obtain another copy from a reliable 
source, such as CompuServe, or contact the author directly.

If you are uncertain whether you have a complete package, see: Distribution Files,    to ensure that all of 
the required files are present

This definition of Shareware is based upon a shareware definition that was provided by the Association of 
Software Professionals.

For more information on the ASP, see: ASP



How Do I Get Rid Of The Annoying Registration 
Reminder Screen?

REGISTER YOUR COPY OF CLIPMATE!



Basic Installation
System Requirements
Installation



System Requirements
To run ClipMate, you will need the following:

Microsoft Windows 3.1 or later.

VGA (or better) video.

Minimum 500K disk space (for the program and typical collection of data).

Minimum 4MB of RAM, if you wish to collect large data types, such as Bitmaps.



Installation
Note: You can install directly from a floppy disk, or from a hard drive.    These directions assume that 
you're installing from the A: floppy, and that the files are de-compressed.    Make appropriate substitutions 
if you are using the B: drive, a CD ROM, or have already copied the files to a directory on your hard drive. 

1. From the Program Manager's FILE menu, choose the RUN command.

2. Enter A:Setup 

3. You will be presented with the CLMREAD.TXT file, from within Notepad.    Be sure to read, any 
WARNINGS that are present.    Quit out of Notepad, by selecting FILE | EXIT.

4. You will then be presented with the installation dialog box.    By default, ClipMate will be installed 
into C:\ClipMate.    If you wish to override this, just highlight and overtype the directory in the 
"Install to Directory" field.    Press OK to continue.

5. The files will now be copied.    Note that if the source and target directories are the same, then no 
files will actually be copied.    Also, if you are installing on top of a previous version of ClipMate, 
then you may be prompted to approve replacement of files with the same name.

6. The next prompt will ask you whether or not the ClipMate icon should be added to the Program 
Manager.    If you answer OK, then the setup program will create a ClipMate group, and place the 
ClipMate icon in it, along with icons for various documentation files.    It is strongly suggested that 
you move or copy the ClipMate icon to the STARTUP group, so that it will run automatically, every
time that you start Windows.    

7. If you are installing over a previous version of ClipMate, your data will be converted to the new 
format when you first run ClipMate.    If you have multiple files, you'll have to open and save each 
one separately from within ClipMate.    By default, ClipMate will try to store all new data files in the
\CLIPMATE\DATA subdirectory.

If you're a new ClipMate user, please see:Overview, and Features new to version 3.0.



Advanced Installation
Windows 3.1 users can take advantage of the HOTKEY, RUN MINIMIZED, and STARTUP GROUP 
features that are inherent to Windows 3.1 (and presumably any future releases of Windows).

Related Topics:
Hotkey
Run Minimized
Startup Group
Specifying Data Files
De-Installation
Distribution Files
ClipMate.INI
CLIPFLTR.INI
What ClipMate Does to Your System
Known Problems



Hotkey
You can set a hotkey combination to activate ClipMate (once it's running) and bring it to the top of all other
windows.    To use, highlight the ClipMate icon in the Program Manager (the one that's actually on the 
Program Manager, NOT the one that represents the running application).    Select FILE | PROPERTIES 
from the Program Manager's menu.    You will be presented with the Properties dialog box for ClipMate.    
Click your mouse in the Hotkey field.    Give it a hotkey, probably some combination of Ctrl + Alt + 
whatever you want.    We use Ctrl+Alt+C (C as in ClipMate!).



Run Minimized
If you normally wish ClipMate to be iconified when run, you can set the properties of the ClipMate icon to 
cause ClipMate to start as an icon.    To use, highlight the ClipMate icon in the Program Manager (the one 
that's actually on the Program Manager, NOT the one that represents the running application.)    Select 
FILE | PROPERTIES from the Program Manager's menu.    You will be presented with the Properties 
dialog box for ClipMate.    Check the Run Minimized check box.    That's it!



Startup Group
The Startup Group is a Windows 3.1 feature that lets you easily determine which programs will 
automatically execute when Windows is loaded.    You will probably want to put ClipMate in your startup 
group.    



Specifying Data Files
If you wish to use a filename for your data, other than DEFAULT.CLM, you can specify your filename as a 
parameter to ClipMate.    In this case the Command Line in the Program Manager would be:    

C:\ClipMate\ClipMate.exe myfile.clm



De-Installation
In the event that you need to de-install ClipMate, there is a short write-up in the CLMREAD.TXT file.    



Distribution Files
The following files are provided with ClipMate, and constitute a complete ClipMate package:

CLIPMATE.EXE    -    The executable program - requires Windows 3.1

CLIPMATE.HLP    -    Help file

CLMICONS.DLL    -    Dynamic Link Library to support the Toolbar

CLMREAD.TXT    -    README file with any special considerations or installation notes

CLMREG.TXT    -    Registration form    

DEFFLTR.INI    -    Default settings for Application Profile (FILTER) 

FILE_ID.DIZ    -    BBS Standard Description File

SETUP.EXE    -    Installation Program

SETUP.INF    -    Installation Program

SITELIC.TXT    -    Registration form for Site Licenses, Multi-User Licenses

VENDINFO.DIZ    -    VENDINFO File for BBS and Vendor distribution 

VENDOR.DOC    -    Not Used - points back to VENDINFO.DIZ

VENDOR.TXT    -    Not Used - points back to VENDINFO.DIZ

Obsolete Files:
HINTS.TXT

FILTER.CLF



ClipMate.INI
The ClipMate.INI file holds various settings and preferences, and is saved every time that ClipMate is 
shut down, whether or not a change has actually taken place.    It has nothing to do with the ASK USER 
vs. ALWAYS SAVE option, found in the CONFIG screen.    

If you ever need to restore default settings, you can delete any and every line in this file, except for the 
lines containing SerialNumber, Registered Name, and Registered Number.



CLIPFLTR.INI
This file holds the "Application Profile" settings.    It is stored in ClipMate's home directory, and is initially 
populated from DEFFLTR.INI, which provides default values for some popular applications.    As ClipMate 
experiences data from applications not already listed in this file, it will grow.    Feel free to share this file 
with others - especially in a workgroup or LAN situation, where you and your co-workers use the same 
applications.    If you come across a popular application (especially a new version) that isn't already listed 
in this file, please feel free to Email or Fax the resulting profile information to us, so that we can include it 
with future releases of ClipMate.



What ClipMate Does to Your System
The first time that you run ClipMate, it will create \Windows\ClipMate.ini.    WIN.INI is not altered in any 
way, nor are any of your other system files.    

ClipMate will create a \clipmate\data directory, where it will store the data that it collects.    You will be 
prompted for permission to create this directory when ClipMate is run for the first time. 

ClipMate will save the clipboard data into DEFAULT.CLM, or another .CLM file that you specify.    



Known Problems
Norton Desktop for Windows users will need to upgrade to Norton Desktop version 2.0 in order to use 
ClipMate.    Also, see write-up in CLMREAD.TXT



Main Window Overview
ClipMate's Main Window contains a drop-down Combo Box, showing the title of the currently-selected clip
item, a toolbar, and pull-down menus.    Buttons and menus provide access to other ClipMate windows, 
and functions.    Often, the buttons will change their appearance, to indicate a particular mode of 
operation, or they may be grayed-out, to indicate the inability to access a particular function.

For More Information See:
Clip Item Selection List Box, and 
Toolbar.



Layout - Full vs. Brief
ClipMate gives you the option of displaying all of its graphical controls, along with the Menu (Full Layout), 
or just showing some of the graphical controls, with no Menu (Brief Layout). When in Brief Layout, some 
of the missing controls and menu options can be found in the Control Menu.    An alternative to Brief 
Layout is to run as an Icon, which also benefits from the Control Menu.

See Control Menu.



Clip Item Selection List Box

The Clip Item Selection List Box is your primary method for recalling data back onto the clipboard.    You 
will use the mouse to activate it, and then make your selection from it's scrolling list of Clip Item Titles.    
Once you've made your selection, the selected Clip Item is copied onto the Clipboard.    

Related Topics:
Using the Mouse
Using The Keyboard
Rules of Thumb



Using the Mouse
The Clip Item Selection List is used to copy CLIP ITEMS from one of the Clip Item Lists back onto the 
Clipboard.    You can accomplish this by simply selecting the title of a stored Clip Item from the Clip Item 
Selection List. 

The Clip Item Selection List is a standard Windows Combo Box, which incorporates a static text window 
with a drop-down list.    By clicking the down arrow icon to the right of the text window, you will see a 
scrolling list, by title, of the Clip Items in the active list.    When you have made your selection, the list will 
go away, the title of the selected Clip Item will appear in the text window, and the item will be copied to the
Clipboard.



Using The Keyboard
Alternatively, you can use the up and down arrows on the keyboard to make your    selection.    This 
sometimes has an advantage, such as when you are browsing the list through the magnification window.   
It is very easy to sequentially zip through each Clip Item by hitting the down-arrow cursor key.    In order to
use the cursor key, you must first give input focus to the list box, or the text window at the top of the list 
box.    To do this, simply click on the text window itself with the mouse, and it will appear as reverse video, 
indicating that it has the input focus.    You should learn to use both methods, as they each have 
advantages.



Rules of Thumb
· Whenever either of the Clip Item Lists becomes active, the top entry of the active list will be 

shown in the text window, and therefore will also be copied to the Clipboard.    This includes the 
initial activation of the Recyclable List, upon startup.

· Whenever the Clipboard contents are erased by an application, or it contains only formats that 
are filtered out by the user-definable filter, the selection list will display a message stating that the 
clipboard is empty, or invalid.

· During certain operations where there is no single current selection, such as Multi-Select, the 
selection list box may display messages, stating that such an operation is taking place.    



Toolbar
         Multiple Selection List Dialog Box  

        ThumbNail Select  

         PowerPaste™  

    Delete  

    Print Text Item  

    Glue Text  

    Magnify Button  

    Copy to Safe List  

    Activate Recyclable List  

    Activate Safe List  



 Multiple Selection List Dialog Box
This option consists of a dialog box that allows you to select more than one Clip Item at a time, as 
compared to the Clip Item Selection List Box, which will select only one Clip Item at a time.    There are 
several operations that take advantage of the multiple selection, such as Delete, Print, Glue, and Copy to 
Safe List.

The Multiple Selection Dialog Box consists of two List Boxes:

The Selection List in on your left.    This is where you make your selections.

The Confirmation List is on your right.    This shows your selections in the order in which you made them.   
It is for your reference only, and can't be manipulated.

Here's how to use the Multiple Selection Dialog Box:

1) If you will need to see the Magnification Window, activate it first before opening the Multiple 
Selection Dialog Box.    Use of the Magnification Window is highly recommended, because it 
makes it easy to see what you are selecting.

2) Press the MS button to bring up the dialog box.    Once the dialog box is up, you can't go back to 
the rest of ClipMate without pressing either OK or CANCEL.

3) If necessary, move and/or re-size the Magnification Window.    

4) The Selection List appears in the list box on the left.    With the mouse or spacebar, select the 
Titles of the Clip Items that you want to work with.    As you make each selection, the Clip Item 
you select is displayed in the Magnification Window.      The Magnification Window only holds one 
Clip Item at a time, so only the most recent selection will be shown.    To de-select, simply click 
again.

5) In the Confirmation List (on the right), your selections will appear in the order that you selected 
them.    This READ ONLY window provides visual confirmation that you have selected the items in
the order that you intended.    It is especially helpful when Gluing Clip Items, because it gives an 
outline of what you are composing.      For the Copy to Safe List operation, the order also comes 
into play.    The items will be copied to the Safe List in the order that you selected them, and 
therefore the order that they appear in the Confirmation Window.

6) If you change your mind about a particular item, just click it again.    The highlighting will 
disappear, and it will be removed from the Confirmation List on the right.    You can select and de-
select as many times as you wish.    

7) When you are done with your selections, press OK.    

8) The Delete, Print, Glue, and possibly Copy to Safe (depending upon what list is currently active) 
buttons will now be enabled.    You can now perform any of these functions using the multiple 
selection.



ThumbNail Select
Opens or closes the Graphic Selection Window.

See: Visual Selection by ThumbNail.



PowerPaste™
When activated, PowerPaste allows you to paste multiple items into an application, without having to 
continuously access ClipMate in order to select the next item.    This gives ClipMate a "hands-off" mode, 
and makes it quick and easy to use ClipMate's data.    

As you paste data into an application, ClipMate senses that you've pasted the current item, and 
automatically advances to the next item.    Paste again, and you get the second item.    Paste once more, 
and you get the third item.    This process continues until you deactivate PowerPaste, or you reach the 
end of the clip list (in the chosen direction).

Related Topics:
Direction - Up or Down?
Selecting The Starting Position
Activating PowerPaste
Ending PowerPaste
Real-Life Example
Troubleshooting PowerPaste



Direction - Up or Down?
As PowerPaste advances its way through the current Clip List, it can either work its way UP (toward 
newer data) or DOWN (toward older data).    Once activated, you can keep pasting until you encounter 
either the top or bottom of the current list.    You select the direction by pressing one of the two "outlets" 
that form the PowerPaste button.    

It is useful to note that when Power Pasting, there is nothing that prevents new data from being copied 
into ClipMate.    It will appear on top of the list, and not at the location of the PowerPaste pointer.    So, if 
you're Power Pasting UP, you can encounter this new data if you continue far enough.    

In the following example, the user has set the Start Point at "Item W", and pressed the UP PowerPaste 
button.    Therefore, pasting data into an application will yield Item W, Item X, Item Y, and then the "Brand 
New Item Z", which enters ClipMate after the PowerPaste has been initiated.    

There are many possibilities.    You could start with "Item A", and work your way up through all of the 
items, in their original sequence.    Or you could start at the top of the list, and work your way down, in 
reverse order.

Note: The direction of PowerPaste determines whether you get the data in the order that you copied, or in
reverse.    UP will preserve the order, DOWN will reverse it.



Selecting The Starting Position
PowerPaste will begin with the currently-selected Clip Item, which will be visible in the Clip Item Selection 
Box.    If you have made no selections, this will be the top of the current list, by default.    This is often 
suitable for Power Pasting DOWN.    If you want to PowerPaste UP, then you won't get very far unless you
select a starting point farther down the list.    Of course, if you plan on copying more data to ClipMate, then
the top might be a fine place to start.



Activating PowerPaste
The PowerPaste button is actually two buttons, an upper outlet, and lower outlet, which correspond to 
PowerPaste (up) and PowerPaste (down) from the EDIT menu.    

When you press either outlet, it "Glows" to show you that it is active.    If you press the other outlet, it will 
"Glow", and the other one will return to normal.    In this way, it works much like a pair of Radio Buttons 
because they are mutually exclusive.    



Ending PowerPaste
Click on the active "outlet", and the operation will end.    Note that if you reach either end of the list, the 
operation will automatically terminate, with an audible Beep.



Real-Life Example
At Thornton Software Solutions, we use PowerPaste every time that we fill orders.    Many of our orders 
come by CompuServe's SWREG service, which is very popular with our customers.    While the electronic
form was always readable and quick, it didn't really save us any time during order entry, as it isn't in a 
format that our order entry system can use.    Early versions of ClipMate helped somewhat, as we could 
copy the data fields, and then paste them (one at a time) into our order entry screen.    Unfortunately, this 
meant a lot of switching back-and-forth between ClipMate and our order entry screen.

PowerPaste solves this problem.    Now we just copy the individual fields from the SWREG order (Name, 
Company, Street1, Street2, City, State, Zip, Country, Quantity, CompuServe ID) into ClipMate.    We do all 
of the orders at once, so there could be a lot of data (the more, the better!)    To set our starting point, we 
pull down the Clip Item Selection List to select the first item of data that we want to paste (the customer 
name of the first order).    Next, we press the PowerPaste Up button, as we want to paste the items in 
sequence, from oldest to newest.    Then, we go to the order-entry screen and tab to the "Customer 
Name" field.    Paste the data, tab to "Company Name" field.    Paste the data, and tab to the next field.    
Paste and tab, until the whole order is done.    Begin a new order, and repeat the paste-tab process.    

As you can see, this is much easier than switching back and forth to ClipMate in order to retrieve the data.
And compared to keying-in all of this data, it's fantastic!

Note: In the above example, we used the TAB key a lot.    This has nothing to do with ClipMate, or 
PowerPaste.    It is just used to navigate from one field to another, in our order-entry screen.



Troubleshooting PowerPaste
There can be problems PowerPasting into certain applications that hold the clipboard open too long when
pasting.    You will get a message from ClipMate saying that there is an "Error Opening Clipboard".    A 
possible work-around is to slow down the PowerPaste action, by adding the following line to the \
WINDOWS\CLIPMATE.INI file, under the [CLIPMATE] heading:

PPDELAY=500

The delay interval is in milliseconds (1000 ms = 1 second).    The default is 100, which is nearly 
instantaneous.    Slowing it down will give your application more time to paste its data, but you need to 
keep this delay in mind when pasting, as you can get ahead of PowerPaste.    



Delete
This operation works with single or Multiple Selections.

Deletes the currently selected Clip Item or Items from the Active List.

The next item in line is then copied to the Clipboard, and that item is shown in the Clip Item Selection List 
Box.

Note: A new feature to ClipMate 3.0 is the ability to delete all clip items.    This can be done with the 
Delete Items | All Items menu item, found under the Edit menu.



Print Text Item
Prints the currently selected Clip Item or Items.

This feature operates on text items only.
This operation works with single or Multiple Selections.

Printer support is very generic.    Output will appear in a font that is supported by your printer, such as 
Courier.    There are no options for fonts, margins, or such.    The purpose of this is so that ClipMate can 
give basic printer services to as many printers as possible.    Now, ClipMate users can print any text that 
they can get into the Clipboard - with only a mouse click!    If you need more sophisticated printing, just 
paste your data to any application that meets your needs!

Item(s) will be printed to the default Windows printer, unless you have specified a printer using the Print 
Setup option, found in the FILE menu.    Once you have chosen a printer with Print Setup, it stays that 
way until you change it to something else.    It is not reset upon shutdown.    This makes it very convenient 
for users with more than one printer.    Many ClipMate users direct their ClipMate output to their desktop 
(dot-matrix) printer, while leaving their shared network (laser) printer for other tasks, such as word 
processing.    

NOTE:    The notion of retaining a printer selection from session to session is not typical practice in 
Windows.    However, it makes sense in this case.    If you use ClipMate to make 3270 emulation more 
bearable, I'm sure you'll agree.    There is a potential pitfall that could arise, if you were to delete the 
printer definition for the printer that you have chosen as ClipMate's printer.    If you do this, just select 
another printer with the Print Setup option of the File menu.    

Note:    In previous versions, there was a shortcut key associated with this function.    It was removed, as it
collided with the shortcut key for Next/Prev item selection.    



Glue Text
This feature operates on text items only.    
If you glue several items that contain multiple formats, only the text component will be Glued.

This feature was known as CONCATENATE in previous versions of ClipMate.

The Glue function concatenates (appends together) selected Clip Item(s) into one big Clip Item.    The 
resulting item is then copied back onto the Clipboard, for use by other applications.

There are two ways to use this feature.    The first method is to turn the "Glue Mode" on, and then copy 
data to the clipboard.    As each item enters the clipboard, ClipMate "Glues" it to the previous occupant of 
the Clipboard.    We'll call this "Auto Glue".    The second method is to glue existing clip items together 
within ClipMate.    We'll call this "Manual Glue".

Related Topics:
Auto Glue
Manual Glue (Formerly known as Concatenate)



Auto Glue
Auto Glue is a special mode of operation, where ClipMate appends each new text item directly to the end 
of it's predecessor, rather than creating new Clip Items for each new piece of text.    If you turn on the 
Glue mode, and then copy 10 paragraphs to the clipboard from other applications, you will have ONE Clip
Item that is 10 paragraphs long.    In addition, the resulting Clip Item will always be on the Clipboard, and 
will be up-to-date (as long as Auto Glue is still on).    You won't even have to interact with ClipMate at all to
use this new item.    

To use, just click the Glue Button, or select Glue Together from the Edit menu.    You should NOT perform 
a Multiple Selection prior to entering Glue Mode.    Doing so would invoke a "Manual Glue", which is 
discussed in the next section.

When you enter Glue Mode, a fresh, empty Clip Item is created.    It will initially have a title stating <<Glue 
In Process...>>.    As you Copy text from other applications, the title will change to indicate the number of 
items that have been Glued together.    To finish, click on the Glue Button again.    The title will change to 
<<Glue Finished, (x) Items>>, and ClipMate exits Glue Mode.    At any time during the Glue operation, you
can utilize the new item in its current state.    

The Auto-Glue Mode will end automatically if you try to use other ClipMate functions while it is active.    
You may open or close the Magnification Window, but only to browse the data.    Any other action will 
terminate the current Glue operation, as if you had pressed the Glue Button to turn the Glue off.    Once 
stopped, you can't re-start a Glue.    However, you can perform a Multiple Selection, and use the Manual 
Glue to put several Glues (or single items) together.



Manual Glue (Formerly known as Concatenate)
This operation requires you to have previously performed a Multiple Selection.

The Manual Glue is useful for making one large Clip Item from several smaller items.    You select the 
items that you want by performing a Multiple Selection, and then pressing the Glue Button (or Glue 
Together from the Edit menu.)    

One advantage that Manual Gluing has over Auto Gluing is that you don't have to plan it in advance.    
Another is that it is easy to change the order of the result, as the Multiple Selection gives you the ability to
select items in any order that you want, and will glue the items in that order.    It also has a confirmation 
window to show you the order that you've selected.

Example of Manual Gluing in action:
Let's say that you need to buy a PC for your office at work.    You sign onto the on-line corporate catalog, 
and browse around to see what's out there.    Whenever you see something that you want, copy it to the 
clipboard.    When you're done shopping, use the Multiple Selection List Dialog to select the components 
of your new computer system, in whatever order you want.    Use the GLUE button to combine your 
Multiple Selection into one big Clip Item that you can then paste into the order form, or on-line order 
screen.    Painless!



Magnify Button
Also accessible from the View Menu.

Opens, or Closes the Magnification Window.    

When the Magnification Window is open, the Magnify Button will appear to be checked.    In this way, it 
functions like a standard Windows Check Box.    When you press it again, it pops up and the Magnification
Window closes.    

For more information, see Magnification Overview.



Copy to Safe List
Availability: This button is not available in the Brief Layout.    

Copies selected Clip Item(s) to the Safe List.          

This operation is only available when the Recyclable List is the Active List.

This operation works with single or Multiple Selections.



Activate Recyclable List
Availability: This button is not available in the Brief Layout.

Also accessible from the View Menu.

Causes the Recyclable List to become the Active List.

The Recyclable Button and Safe Button are bound together, and act like radio buttons.    When you press 
one, it takes on a depressed appearance, and the other button pops out.    This makes it easy to see 
which list you're working with.



Activate Safe List
Availability: This button is not available in the Brief Layout.

Also accessible from the View Menu. 

Causes the Safe List to become the Active List. 

The Recyclable Button and Safe Button are bound together, and act like radio buttons.    When you press 
one, it takes on a depressed appearance, and the other button pops out.    This makes it easy to see 
which list you're working with.



Menus
While ClipMate's most often-used features are represented by buttons on the toolbar, there are still more 
functions to be found in the menus.    The next several pages describe the functions that are found in the 
menus.    Full descriptions are given for functions that are unique to the menus.    Where a toolbar 
equivalent exists, a reference is made to that description.    

The Main Menu is not available in the Brief Layout.

Related Topics:
Control Menu
File Menu
Edit Menu
View Menu
Config Menu
Help Menu



Control Menu
The Control Menu is a special menu that is accessed by clicking on the "System Box" on the upper-left of 
the main window, or by single-clicking on the ClipMate icon (when minimized).    It duplicates many of the 
menu options found in the regular Main Menu (so we won't list them here).    It is very handy when you 
have the Main Menu turned off, when using the Brief Layout, or when running ClipMate as an Icon. 



File Menu
The File menu includes commands that enable you to open and save ClipMate files.

For the most part, it will not be necessary for you to ever choose any of these.    ClipMate will 
automatically open DEFAULT.CLM when it launches, or a file that you specify on the command line (of the
icon that launches ClipMate).    Upon closing, ClipMate will attempt to save both of the Clip Item Lists 
(Recyclable and Safe) into the current file.    Depending upon the option that you have selected in the 
CONFIG screen, you may be prompted before the file is saved.    Therefore, if you always use 
DEFAULT.CLM,    you will never need to use the FILE menu.    

Here are the menu options:

·    New    -    Clears storage, creates a new file.

·    Open    -    Opens existing file.

·    Save    -    Saves current file.

·    Save As    -    Saves current file with new name.

·    Print Setup    -    Set printer    See: Print Text Item.

·    Print Item(s)    -    Prints current item, or multiple-selection of items.    See: Print Text Item.

·    Exit    -    Ends ClipMate.    Alternatively, double-click on the control box (in the upper left hand 
corner) in the main window.

EXIT NOTE:    If Always Save is checked in the CONFIG screen, then the current file (usually 
DEFAULT.CLM) will automatically be saved.    Otherwise, you will be prompted to save changes if either 
list has been added to or modified in any way.    The ClipMate.INI file in the Windows directory will be 
updated upon exiting from ClipMate.    



Edit Menu
The Edit Menu allows you to manually alter the contents of either of the two lists.

Most commands are available on the Icon Bar, and are further described in the MAIN WINDOW section.

· Delete Item  -    Remove Clip Item from active list.    See Delete.

· Edit Title    -    Changes the title of a Clip Item.

The Edit Title dialog box allows you to change the title of a Clip Item.    Although the title is initially 
constructed from the first 50 characters of the Clip Item, changing the title will have no effect on 
the Clip Item.    It is provided for your reference only.    

As an alternative to this dialog box, you can edit the title in the Magnification Window.    

· Glue    -    Glues CLIP ITEMS together. See Glue Text.

· Flow Paragraph      -    Removes unwanted Line-Breaks from TEXT.    See: Flow Paragraph 
Button.

· Copy to Safe List    -    Puts a copy of the selected Clip Item on the Safe List. See Copy to Safe 
List.

· PowerPaste      -    Up/Down - Initiates/Terminates PowerPaste.    See: PowerPaste™.



View Menu
The View Menu allow you to change the Active List, open or close the Magnification Window, or perform 
word searches with the Find or Find Next commands.    

Most commands are available on the Icon Bar, and are further described in the MAIN WINDOW section.

· Toggle Recyclable List    -    Switch from Safe to Recyclable list.    See: Activate Recyclable List.

· Toggle Safe List      -    Switch from Recyclable to Safe list.    See: Activate Safe List.

· Magnify    -    Open Magnification Window.    See: Magnification Overview.

· ThumbNail Select    -    Open ThumbNail Selection Window.    See: Visual Selection by 
ThumbNail.

· Find    -    Find item by text content or title.    See: Find, Find Next.

· Find Next    -    Repeat Find.    

· Select Previous/Next    -    Select Prev/Next item current list.    See:Select Previous/Next.

Related Topics:
Find, Find Next
Select Previous/Next



Find, Find Next
You can use the accelerator keys, (CTRL+F and F3, respectively) even if the view menu is not visible 
(Brief Layout).

The Find command will prompt you for some text to search for, and then search the Active List for the first
occurrence of the specified text.    It is NOT case sensitive, and you can use partial words.    Wild Cards 
are NOT supported.

If the string is found, the corresponding Clip Item is selected, and displayed in the Title Window of the Clip
Item Selection List Box.    If not, then you will receive a notification message, and the Title Window will be 
blank.

If the Magnification Window is active, then it will also reflect results of the search, in the same way that 
the Title Window of the Clip Item Selection List Box does.    



Select Previous/Next
Select Prev/Next item current list.    If ClipMate's Window has focus, you can use the hotkeys: Ctrl+N, 
Ctrl+P to scroll through the list.    This can be very handy if you like to keep your hands on the keyboard.    
If you do, be sure to use it in conjunction with a HOTKEY.    See Hotkey.



Config Menu
Auto Capture
User Preference Dialog Box
Application Profile (FILTER)
Lock Icon Position



Auto Capture
ClipMate's most powerful feature is the ability to automatically capture clipboard traffic.    However, 
sometimes you may want to turn this feature off, and still leave ClipMate running.    For example, if you 
have a lot of editing to do in an Excel spreadsheet, and you really don't want to keep any of the resulting 
data in ClipMate.    BUT, you need to paste things FROM ClipMate into Excel.    Just toggle the Auto 
Capture option from the CONFIG or CONTROL menus.    

Note: When Auto Capture is disabled, the ClipMate title bar will say NOT CAPTURING, and if iconified, a 
big X will appear over the icon.

Note: Unlike most settings, this setting will NOT be saved from one session to the next.



User Preference Dialog Box
Accessible from the CONFIG pull-down menu (when ClipMate is in the Full Layout) or the CFG Button 
(when ClipMate is in the Brief Layout).    

The Config Dialog Box lets you change various settings of ClipMate's main window.    The settings are 
stored in the ClipMate.INI file for later retrieval.    

Automatically Save Current File When Shutting Down?
When you close ClipMate, a check is made to see if the current file needs saving.    If so, then this value 
determines whether ClipMate will prompt you first before saving the file.    The "Current File" is the .CLM 
file that ClipMate is currently using to store the clipboard data (usually DEFAULT.CLM, unless you have 
specified otherwise).

Default: Always Save 

Where to Put New Clipboard Items?
When ClipMate detects that there is a new Clip Item to retrieve from the Clipboard, it must decide which 
list to put it in. If the Recyclable List is currently active, then the new item will always go there.    If the Safe
List is active, then it checks this value, and places the item accordingly.    This is useful in order to keep 
from cluttering up your Safe List with trivial items, if you happen to have the Safe List active.    On the 
other hand, you may want to turn on Current Active List, if you want to collect some items that you want to
keep for a long time.

Default: Recyclable List

Number Of Items To Keep In Recyclable List
This allows you to control the length of the Recyclable List.    ClipMate will accumulate Clip Items in the 
Recyclable List, and allow the list to grow until this limit is reached.    When the list is at its limit, the oldest 
item will drop off from the bottom for every new item added to the top.    

Note:    Increasing this value will cause ClipMate to keep more Clip Items, but the trade-off is that it will 
use more memory.

Note: This has no effect on the number of items kept in the Safe List, which can grow indefinitely.

Default: 100 (Clip Items saved in the Recyclable List)

Keep Window on Top?
This allows ClipMate to "float" to the top of all other windows.    It is especially helpful when you have a lot 
of windows open, or if you are using an application that is running full-screen, such as a word processor. 

When ClipMate is iconified, it will also continue to float on top.    This is very useful if used in conjunction 
with the Lock Icon Position and Use Clip Item Title As Icon Title options.    

Default: unchecked (no)

Full Layout?
ClipMate gives you the option to display all of its graphical controls, along with the Menu (Full Layout), or 
just show some of the graphical controls, with no Menu (Brief Layout).    This is where you make that 
choice.    See Layout - Full vs. Brief.

Default: Full Layout

Beep When Clipboard is Updated?
ClipMate has the option of beeping every time that the clipboard is updated.    This is often a useful tool 
for learning how ClipMate works, or how various applications behave.    

Default: unchecked (no)

Use Clip Item Title As Icon Title?



ClipMate now has the ability to use the title of the current Clip Item as the title shown under the Icon when
it is Iconified.    As the clipboard contents change, the title is updated.    This is very handy if you like to 
minimize ClipMate to an Icon.    Very useful when used in conjunction with these options:    



Application Profile (FILTER)
This opens the Application Profile dialog box, which allows you to determine which formats ClipMate will 
collect.    

See: Application Profile.



Lock Icon Position
This locks the position of the ClipMate icon.    Do you routinely move the minimized icon to the same 
place, every day?    If so, this feature is for you.    Just move it to where you want it, and lock it.    It won't 
move from that spot until you unlock it.    Very useful in conjunction with the "Use Clip Item Title As Icon 
Title", and "Keep Window On Top" options.

See: User Preference Dialog Box.



Help Menu

About 
Accessible from the Help | About pull-down menu (when ClipMate is in the Full Layout) or the ? Button    
(when ClipMate is in the Brief Layout).    

In addition to displaying the "normal" about information, this Dialog Box gives you the opportunity to 
register ClipMate, and access the on-line help.    The HELP button is provided in order to give access to 
HELP when ClipMate is in the Brief Layout. 

Help Info:
· Release Date    -    If over 1 year old, see if a newer version is available.    See: Obtaining Current 

Version Of ClipMate.

· Number of Clip Items:    -    Total of both Recyclable and Safe Lists.

· Registered To:    -    Hopefully You!



Magnification Overview
The Magnification Window displays the Clip Item that is currently selected in the Clip Item Selection List 
Box.    It permits you to get a full look at what the Clip Item actually looks like, rather than just a glimpse of 
the title.    Also, you can edit either the Clip Item (text only), or the Title.    There is a powerful Flow 
Paragraph function that will reformat the Clip Item by removing unwanted line breaks and spaces.      This 
makes the text more usable by word-processing applications.

    

The Magnification Window is opened by either selecting the Magnify option under the View menu, or by 
pressing the Magnify Button.    Upon opening it the button will display its "Depressed" (checked) state.



Magnification Controls
Fields
Browse Buttons
Make Title
Flow Paragraph Button
SHIFT TEXT << >>
Wrap Text Checkbox



Fields
· Title -    Title of Clip Item (Editable).

· Format List - List of formats.    Change format displayed by selecting format.    ex:    if data 
contains PICT, BITMAP, and PALETTE, you can see either of these by selecting from this list. 

· Date/Time - Time stamp of when the data was created.

· Source - Name of source application that provided the data.    If OLE2, then it will specify OLE2 
and type of data, such as Word 6.0 Document.

· Size - Bytes, bitmap dimensions, or number of palette colors.

· Serial Number - Serial number of item.    Each item is assigned a serial number for assignment of
titles, and for storing large items on disk.    



Browse Buttons
The Browse Buttons will select the previous/next Clip Item in the Active List. 

Moves you toward the top of the list (Newer Clip Items).

Moves toward the bottom of the list (Older Clip Items).    
As items are selected, they are Copied to the Clipboard automatically.    
If you try to browse past either end of the list, ClipMate will issue a short beep to let you know that there is
nothing to browse in that direction.



Make Title
The Make Title button will form a new Clip Item Title from the selected text.    This is useful when the Clip 
Item contains a text passage that you want to use as the title.    

To use, just select some text (with your mouse), and then press the button.    ClipMate will make a new 
title out of the selected text, up to the first 50 characters.    The new title is immediately reflected in the title
box, and the Clip Item Selection List Box.



Flow Paragraph Button
Note: This feature is now accessible from the Edit menu of the main window, and from the Control Menu.  

The Flow-Paragraph button re-formats the Clip Item so that it may be easily used by word processors.    It 
removes all of the extra line breaks and spaces that often are embedded within text that is copied to the 
Clipboard.    Here's an example:

If your text looks like this when it gets into your word processor:
    This is some text that was taken 
from DOS and
it doesn't fit very well into the 
word processor.  
I would rather let the word processor 
make the important
decisions, such as where the margins should 
go, and whether 
the paragraph should be indented.  I hope I 
don't have to 
manually remove all of that junk! 

You can use the Flow Paragraph button to make it look like this:
This is some text that was taken from DOS and it doesn't fit very 
well into the word processor.  I would rather let the word 
processor make the important decisions, such as where the margins 
should go, and whether the paragraph should be indented.  I hope I
don't have to manually remove all of that junk! 

The newly-formatted text only has line breaks that define the end of a paragraph, or breaks between 
paragraphs.    Individual lines flow together to form paragraphs.    You can then use your word processor to
format the paragraph any way you want!

Most applications have their own quirks about how they put text on the Clipboard, therefore ClipMate's 
conversion algorithm is pretty generic at this point.    It should cover most cases - if you find a 
shortcoming, please contact the author, and describe your particular situation and applications involved.    
Here is a summary of the algorithm that ClipMate currently uses to convert paragraphs:

1. Any blanks at the beginning of any line are removed.

2. Any occurrence of multiple blanks is removed, with the following exception: Two blanks are 
allowed to follow a period.

3. Any Line Break that is not immediately preceded or followed by another Line Break is removed.

You can convert more than one paragraph at a time, as long as there are at least two line breaks between
them.    One of these terminates the last sentence of the first paragraph, and the other one splits the two.   
More line breaks are OK.    If only one line break is used, then the paragraphs will be joined together.

Note:    Once the text has been flowed, word-wrap will be turned on, indicated by the activation of the 
Wrap Text Checkbox.    See: Wrap Text Checkbox.



SHIFT TEXT << >>
By pressing the << or >> buttons, the text will shift one space to the left or right, respectively.    This 
causes the text to be indented, or un-indented.    You can press multiple times, to shift multiple columns.    
This is a handy feature for anyone editing text documents with an editor that lacks the shift feature, or for 
anyone editing files on a mainframe.



Wrap Text Checkbox
The Wrap Text Checkbox is used to control whether or not the Magnification Window displays the Clip 
Item in a wrapping edit box.    If the edit box doesn't wrap, a horizontal scroll bar is provided.

It is set automatically when you perform a Flow Paragraph.    Each Clip Item knows whether or not it 
should wrap.    As you browse through Clip Items, the check box will change, to reflect the wrap state for 
the current item.    You can click it to change the setting for a given item.    

The setting is embedded within the Clip Item, and is therefore stored to disk between sessions.



Editing
You may edit either the text of the Clip Item, or its title.      When you edit the title, it won't appear in the 
Clip Item Selection List immediately.    The Clip Item Selection List will be updated when another Clip Item
is selected.    Editing the title has the same effect as Edit Title.    

Related Topics:
Editor Hot Keys



Editor Hot Keys
The following standard Windows Accelerator keys (hot keys) can be used in the Magnification Window:

Backspace Deletes the character to the left of the insertion point.    

Del    Deletes the character to the right of the insertion point. 

Ctrl+X (CUT)    -    Deletes the selected text and places it on Clipboard.

Ctrl+C (COPY)    -    Places selected text on Clipboard.

Ctrl+V (PASTE)    -    Inserts text from Clipboard to the active window.

Note: Cut/Copy/Paste cause the clipboard to be updated, and therefore cause the Magnification Window 
to display whatever you have just copied to or pasted from the Clipboard.

Related Topics:
Copying To The Clipboard
Cross-Platform Editor



Copying To The Clipboard
You can copy part or all of the Magnification Window to the Clipboard, and thus back into ClipMate by 
using the accelerator key for copy: Ctrl+C.    To do so, just select the text that you want to copy, and press 
Ctrl+C.    You are then presented with only the text that you have selected.    How is this?    Your new text 
was copied to the Clipboard, and so ClipMate made itself a copy.    New Clip Items are always made the 
current selection, as they reflect the current Clipboard contents (unless the Safe List is currently active).    



Cross-Platform Editor
If you work in a multi-platform environment, you undoubtedly encounter a variety of non-windows editors, 
such as vi, Emacs, and ISPF, each with its own personality, and each with different command sets.    As a 
Windows user, you may be baffled by the lack of a common user interface.    Furthermore, you may not be
interested in becoming an expert in any of these editors!

Many ClipMate users find that they can leverage ClipMate to compensate for a lack of expertise with such
environments.    If you can Copy & Paste with these applications (usually through the functionality of the 
terminal emulator), then you can use ClipMate to perform some of the simple editing for you.    Just copy 
the text into ClipMate, use the Magnification Window to edit, and paste back into the other environment.    
You may need to delete the old text from the target application first, go into "insert" mode, and then use 
the terminal emulator to paste.

This is also very handy when working with the unix command prompt (again, assuming terminal 
emulation). If you type a long unix command that doesn't quite work, and you're not a unix expert (i.e. you
don't know how to edit the command without retyping), then you can just copy to ClipMate, open the 
Magnification Window, edit the command, and paste back into unix.    Very handy!



Visual Selection by ThumbNail
The ThumbNail Window is accessed by selecting "ThumbNail Select" from the VIEW menu, or by 

pressing the  button.
The Graphic Select window is used to select Clip Items visually from a grid, consisting of ThumbNail 
images.    The dimensions of the grid can range from 2x2 up to 8x8 (thumbnails).    When a BITMAP 
image is too large to fit within the bounds of its square in the grid, it is scaled down to a ThumbNail 
sketch.    PICTURE images always scale up or down to fill their square, because PICTUREs are 
scaleable, by nature.    Text items can be shown, as well.

This screen shot shows a 2x2 grid of 4 items.    The first is small enough that it doesn't require a 
ThumbNail.    The next is a scaled-down version of the original "arches.bmp".    Following that is a 
PICTURE image of the "ClipMate at Work" graphic.    It is automatically scaled to fit within its box.    The 
last is a text item, scaled down to a very small font.    Although the text can't be read, the distinct layout of 
the text often gives a visual cue as to the nature of the text, or the origin.    In this case, this data is from 
an electronic order for ClipMate, which has a distinct visual format, and can be easily recognized.

Note: The Font Size displayed in the graphic grid is for local display purposes only, and has no relation to 
the font that was used in the originating application 

Selection of data is performed by clicking on a square with the mouse.    If you open the Magnification 
Window, you'll see your selection appear.    

Sometimes you'll notice a green rectangle surrounding an item.    This is to let you know that this item 
doesn't yet have a ThumbNail.    This occurs when items are new, or if the grid has been made smaller 
since they were originally copied.    New items will automatically generate a ThumbNail when the data is 
saved.

Related Topics:
ThumbNail Controls
ThumbNail Configuration Dialog Box



ThumbNail Controls
Each ThumbNail is a Button
Browse Buttons
Done
Config
Mag
Help



Each ThumbNail is a Button
Just click on a ThumbNail picture to load its larger counterpart into ClipMate, and make it the current clip 
item.



Browse Buttons
Allow you to page forward and back, a screenful at a time.    



Done

Quit this Window.    Or, you can press the  button on the main window.



Config
Opens the Graphic Configuration Dialog Box.    

See: ThumbNail Configuration Dialog Box.



Mag
Opens or closes the Magnification Window.    Although there are several other ways to open/close the 
Magnification Window, this button is also added as a convenience.    Note that the two windows will be 
easiest to use when they do not overlap each other.    We suggest finding good "homes" for the 
Magnification Window, and the ThumbNail Window, and leaving them in the same place most of the time. 

See: Magnification Overview.



Help
Summons Help for this window.



ThumbNail Configuration Dialog Box
This dialog allows you to configure the appearance of the ThumbNail Window.

Related Topics:
Display Mode
Display Preference
Font Size for Text
X*Y Dimension
Refresh Thumbnails On Save?



Display Mode
You have the option of showing text, graphics, or both in the Graphic Select window.    Use the Display 
Mode to set your preference.

Text - allow text to display.

Graphics - allow graphics (BITMAP or PICTURE) to display.



Display Preference
If both BITMAP and Picture are both present, which one is shown?



Font Size for Text
The size that text items will be displayed in the grid.    This has absolutely no relationship to the font which
the data was displayed in when it was originally copied, nor does it affect the data later on, when it is 
pasted to something else.    It is simply for purposes of display in the graphic selection window.



X*Y Dimension
Determines the dimension of the grid.    From 2x2 squares up to 8x8 squares. 



Refresh Thumbnails On Save?
For the sake of speed and convenience, the thumbnails are stored on disk, once the item that they 
represent has been saved.    As the window size is adjusted, they aren't automatically re-sized because 
they are often "close enough" to do the job.    You can force a re-generation of all thumbnails by checking 
this box, and then saving the clip file (from the Main Window's FILE | SAVE menu, or by shutting down 
ClipMate).    Note that this may take the shut-down process a little longer than normal.



Clipboard Formats
The Windows clipboard can simultaneously hold the same data item in many different formats.    To 
ensure compatibility and interoperability with as many applications as possible, most software packages 
will provide data in several formats.    There are extreme examples, such as Microsoft Excel, which often 
provide as many as 17 clipboard formats, representing the same item of data!    

Analysis shows that not all formats are viable, once the host application loses ownership of the clipboard. 
Many of these formats simply evaporate, and others become invalid.    

Furthermore, many of these data types become quite large and can quickly become a drain on resources.
For example, if you copy a screenful of spreadsheet cells you could end up with a 600K BITMAP and a 
large PICTURE drawing of your cells, along with your textual data!

To top it off, many of these formats aren't usually provided at the time of the copy.    Instead, applications 
will simply inform the clipboard that they CAN provide these formats.    Think of it as a sort of "advertising".
When an application actually asks for the data in a particular format, the clipboard informs the host 
application that the particular format is requested, and the host application then provides the data.    This 
process is known as "Delayed Rendering", and can cause ClipMate to appear to dramatically increase 
the time needed to copy data.    

So far, it sounds like a lot of bad news.    Will ClipMate's new features bury you in data that you don't want,
and make it take longer to copy data?    The answer is NO!    ClipMate's Application Profile facility allows 
you to determine what formats will be retained, and which formats will be ignored.    The filtration can be 
defined globally, or by application by application, to give you the flexibility that you need.

For more information on the use of Application Profiles, See: Application Profile.

Related Topics:
TEXT
OEMTEXT
OWNER DISPLAY
BITMAP
PICTURE (Metafile)
Rich Text Format
Private Formats
OLE (Object Linking and Embedding)



TEXT
An array of character data with a hard return (carriage return + linefeed) terminating each line, with no 
associated font, size, margins, or other formatting.



OEMTEXT
Data is identical to TEXT format, but the Clipboard Viewer (the one that comes with Windows) displays it 
with a proportional font.    Applications receiving data don't treat it any differently, so there is no value in 
capturing OEMTEXT when TEXT is available.    For that reason, ClipMate always ignores OEMTEXT.



OWNER DISPLAY
Also known as Owner Draw.    This is not really a clipboard format at all, because it is just a method for a 
host application to display it's data within the window of another application, such as the Clipboard 
Viewer.    There is no data on the clipboard, so ClipMate will always ignore this transient format.



BITMAP
A graphic image, composed of individual pixels, or dots.    ClipMate can handle bitmaps of any number of 
colors.    When displayed on a video adapter capable of displaying 256 colors, bitmaps are often 
accompanied by a palette, which optimizes the colors of the display to enhance the image.    When 
running 16 or 24-bit video cards with proper drivers, a palette is not needed and is not usually present.

Bitmaps are often used for very complex images originating from the real world, such as photographs.

Bitmaps are common in Windows, and can be created by the Paintbrush program that comes with 
Windows.



PICTURE (Metafile)
The proper name for this format is actually METAFILE.    It is also called MetafilePICT, and Vector 
Drawing.    

Metafiles are graphic images that consist of one or more common drawing objects, such as rectangles, 
circles, lines, and formatted text. Metafiles are most suited to human- or machine-generated images, such
as architectural or engineering drawings, or clip art.    Metafiles are scaleable, and they often look as good
full-screen as they do when scaled down.    Metafiles often contain text, with font information.    This often 
makes them desirable for corporate logos.    When printed, the image is re-drawn at printer resolution.    If 
you have True Type fonts in a Metafile, they will look FANTASTIC when printed.

Most commercial drawing programs can generate Metafiles, and so can the OLE drawing module 
(DRAW) that comes with many of the Microsoft products.



Rich Text Format
Rich Text Format (RTF) is a private clipboard format employed by Microsoft applications, to enable them 
to share formatted text.    Several non-Microsoft packages have adopted this format as well.    RTF 
contains all of the formatting for text such as font, size, color, margins, borders, etc.    It can even contain 
other items, such as graphics and OLE objects.

RTF is usually very large.    It is not unusual to see RTF clipboard items of 200 - 600K in size.    Also, it will 
usually take an application several seconds to produce the RTF format, and place it on the clipboard.    
The reason that you might not notice the delay is that RTF is a prime candidate for Delayed Rendering. 



Private Formats
There is an established and publicized list of standard clipboard formats, which are known as public 
formats.    Most of the popular ones are listed above.    Applications may generate their own private 
formats at any time.    Public formats are the most useful, because they are usually supported by a wide 
variety of applications.    Examples are Text, BITMAP, and PICTURE.    Private formats, on the other hand,
are generally useless to any application besides the application that created the data.    Sometimes 
several applications from the same vendor will share private formats, which makes them more useful.    
Most often, the data is only useful to the application that created it.

Since most private formats are usually meant to be used only by the originating application, there is a 
potential hazard involved when using them.    Often, these formats are just pointers that refer to data 
structures residing within the original application, and don't actually contain the data at all.    These are 
transient formats. If ClipMate re-posts this format to the clipboard at a later time, the pointers are invalid.   
This can cause a Run-Time Error or GPF in the original application.    If you find that this is the case, you'll
have to remove the offending format(s) from the filter for that application.



OLE (Object Linking and Embedding)
ClipMate has the ability to store OLE objects.    Simply stated, OLE lets applications that use different data
formats share data without converting the data to a common format.    For example, a sound object can be
pasted into a word-processing document.    The sound can then be played back by activating the object 
(double-click).    Your word processor doesn't have to know how to play sounds - it just has to follow the 
rules of OLE.    In many cases, the OLE object can be activated or edited by double-clicking on it.    In 
Microsoft Word for Windows, for example, the draw program is an OLE server.    Double-Click on a 
graphic, and it activates the Draw program to edit the object.    Within the Draw program, there is no 
option to save the file - instead, the option is to update the drawing in the Word for Windows document.    
You can do the same thing with an Excel spreadsheet object.    You can actually embed a spreadsheet 
within a word processing document.    Don't like the numbers?    Double-click to edit the object in Excel.    
Instead of saving the Excel file, you update the Word document.    In these cases, the Word for Windows 
document is considered to be a Compound Document, because it contains other types of data within 
itself.    

OLE is initiated by an OLE Server copying data to the clipboard, and then by an OLE Client pasting that 
data into itself.    The OLE Client looks at the list of available formats, from top to bottom.    If it finds an 
acceptable format, it just uses that format, and doesn't bother with OLE.    Otherwise, it finds the series of 
formats that magically comprise an OLE object, and pastes them into itself, creating the object.    These 
magic formats that make OLE happen are:

1. OBJECTLINK    -    Where did the data come from?

2. OWNERLINK    -    Which application owns the data?

3. NATIVE    -    The data itself.

4. PICTURE, DIB, or BITMAP    -    The "Presentation Format".    

5. DataObject    -    Required for OLE2.

6. Object Descriptor    -    Required for OLE2.

7. Link Source Descriptor    -    Required for OLE2.

The Presentation Format is a special case.    One of these formats is used to display the data in the client 
application.    The nature of this depends on the nature of the OLE object.    For a sound object, it would be
an Icon of the sound recorder.    For a graphic object, it would be a picture or bitmap of the graphic itself.    
Have you wondered why you get silly icons of certain applications when you're copying formatted text?    
This is because the application is conforming to OLE.    

Related Topics:
Using OLE in ClipMate



Using OLE in ClipMate
When defining your Application Profile for any given OLE Server (such as the Sound Recorder), make 
sure that you include all of the necessary formats: ObjectLink OwnerLink, Native, and a Presentation 
Format.    By your having done this, ClipMate will capture and preserve the OLE objects.    Beware that 
OLE objects can get quite large.    If you want to enable OLE2, then you will also need DataObject,    
Object Descriptor, and Link Source Descriptor.



Application Profile
The Application Profile provides a means for reducing the amount of unwanted clipboard data that is 
collected by ClipMate.

As discussed in the section on Clipboard Formats, ClipMate would quickly become unusable if it 
automatically captured every item of data, in every format provided.    ClipMate's Application Profile facility
allows you to be selective about the data formats that ClipMate will capture, on an application-by-
application basis.    

You can configure ClipMate's Application Profile to allow only certain types of data, from certain 
applications.    You could easily configure it to capture TEXT and Rich Text Format from Word for 
Windows, BITMAP from Paintbrush, Picture from Corel Draw, and to ignore Excel completely!    ClipMate's
Application Profile ensures that you deal only with the formats that you choose to work with.

One of the important new features of ClipMate 3.0 is the ability to automatically determine proper filters.    
ClipMate tries to determine whether the application sending data is a writing application, or a drawing 
application.    For writing applications, it will automatically enable TEXT and any of the known formatted 
text formats, such as Rich Text Format.    For a drawing application, it will enable PICTURE and BITMAP.   
If neither of these cases is apparent, then it will present you with a list of available formats, and ask you to
pick the format(s) that you want to capture.    This should occur rarely, if ever, because most applications 
will provide at least one of the formats mentioned above.

Here is the Application Profile dialog box which is accessed from the CONFIG or CONTROL menus.    It is
presently displaying the settings for a Microsoft Word 6.0 Document.    Notice the OLE2 as part of the 
application title.    This indicates that Word is utilizing the OLE2 facility to handle the copying.    Likewise, 
many of the formats listed are OLE-related.    Usually, you'll find that the OLE objects are a bit bulky, and 
that leaner formats such as Rich Text Format and TEXT get the job done more efficiently.    Therefore, the 
selected formats are TEXT and RICH TEXT FORMAT.    By clicking on the (x) checkmark, you can select 
or de-select a format.    Of course, this be implemented beginning with the next item copied from that 
application, and will not retroactively apply to previously copied items.

In the box on the right are notes about the various formats provided, if we know anything about them.

Note that it is certainly acceptable to have no formats selected.      This causes ClipMate to ignore all data 
from a given application.

The Application Profile continues to learn more and more about your applications as you work with them.   
Unlike version 2.0, it keeps a complete list of all formats encountered by the various applications, not just 
the ones that you want to work with.    Undesirable formats are just displayed with no checkmark (x),    as 
opposed to the desired formats which have the checkmark.    If ClipMate encounters an unlisted format for
an application with an existing profile, it will add the new format to the list, in the un-checked state.    It is 
then available to be selected by you, if you choose to work with it.    This will happen often with 
applications like Microsoft Access, which uses different formats for different aspects of a project (controls, 



data, report, etc.).

See: Clipboard Formats.

See: CLIPFLTR.INI.

Related Topics:
Format Viability Test



Format Viability Test
The Format Viability Test can help you to troubleshoot problems with the clipboard and determine whether
an application does indeed provide any formats that are worth keeping.    Simply put, it involves using the 
clipboard viewer that comes with Windows (clipbrd.exe) to capture data, save it to a file, read the file back
in, and paste it back into the originating application.    There are four likely results:

1. A successful paste, with good-looking data.    This indicates that there is at least one format that 
has what you need.    All you need to do now is to figure out which format is the best, and create a
filter for just that format, and maybe something that will show up in the Mag Window, such as 
Text.    

2. A successful paste, with strange-looking data.    In this case, the application is holding back the 
most useful format.    Microsoft Excel is an example of such an application.    None of its 21 
clipboard formats are as good as an internal paste.    Try experimenting with different filters, to see
which format comes closest.    Hopefully, something will be useful.    

3. A failure message.    The application tried to use one of the formats, but it was invalid.    The 
application was smart enough to recognize this.    Most likely, the offending format is a private 
format, used internally by the application.    It probably is a pointer to some data that is now 
invalid.    See if there are any special paste options, like Paste Special.    Perhaps one of the other
formats will work better.    Try to use ClipMate's Application Profile to eliminate the offending 
format.    Often, private formats will have a name that indicates the application.    You need to find 
the best format(s) to include, and absolutely need to eliminate the offending formats by having 
them un-checked in the Application Profile.        

4. A fatal error in the application.    The same case as (3) above, but the application wasn't smart 
enough to see the problem in time.    Use the same techniques to get out of trouble.

Conducting The Test:
1. Close ClipMate, if it is running.    The test will be conducted without ClipMate, in order to avoid 

confusion.

2. Open the Windows clipboard viewer (the one that comes with Microsoft Windows - clipbrd.exe)

3. From AppXYZ (your application), copy some data.    If AppXYZ is a word processor, copy several 
paragraphs, preferably with different fonts.

4. Click on the clipboard viewer.    Pull down the DISPLAY menu, and write down the list of the 
formats provided.    

5. Close AppXYZ.

6. Click on the clipboard viewer AGAIN.    Pull down the DISPLAY menu, and write down the list of 
the formats provided.    Has the list changed?    What's missing?    

7. Save the clipboard to a file, using FILE | SAVE AS.    Call it AppXYZ.CLP

8. Delete the clipboard contents, using EDIT Delete.

9. Open AppXYZ.CLP, using clipboard's FILE, OPEN.

10. Has the format list changed? (Use the DISPLAY Menu to check).

11. Run AppXYZ again.

12. Paste the data.    Does it look OK?    If so, then we're in business.    One of the formats on the 
clipboard is a winner.    Experiment with filters, and see what you can eliminate.    I recommend 
keeping TEXT because it will help you to identify data and see it in the Magnification Window. 

For more information on the cause behind some of the problems outlined here, see: Unfortunate 
Clipboard Tricks.





Troubleshooting

Unfortunate Clipboard Tricks
Not all applications treat the clipboard the way that you would expect them to.    In many cases, software 
developers take "shortcuts" when dealing with clipboard operations.    These shortcuts can sometimes 
cause problems when using ClipMate, although they are not usually serious.    We have arbitrarily 
assigned names to these phenomena, such as "Local Clipboarding" and "Silent Clipboarding".    

Related Topics:
Local Clipboarding
Silent Clipboarding
Transient Data



Local Clipboarding
Unfortunately, many applications prefer to use the clipboard only as a means of exchanging data with 
other applications.    When you perform a CUT or COPY within these applications, the clipboard is not 
necessarily updated with the "good stuff" that the application uses internally.    Instead, it creates formats 
that might be useful to other applications.    Subsequently, when you PASTE within the same application, it
tends to use its LOCAL copy, rather than the data that is on the clipboard.    For this reason, data that is 
stored in ClipMate may not exactly match the data that was copied.



Silent Clipboarding
Some applications, such as the OLE DRAW module that comes with some Microsoft products, use this 
mode of operation.    If you use the DRAW package and copy several items, you'll find that only the last 
one shows up in ClipMate.    But how is this?    The whole idea of ClipMate is that it holds more than one 
item!    

That is all well and good, as long as applications actually update the clipboard when performing cuts or 
copies.    In order to save time, the DRAW module works locally, and bypasses the clipboard.    When it 
senses that the user has given focus to another window, either by closing DRAW, or by clicking outside of
its borders, it then updates the clipboard.    Thus giving the illusion of clipboard support.    Unfortunately, 
ClipMate can't detect anything that DRAW is doing until it updates the clipboard.    

There is a clumsy, but effective work-around.    Keep ClipMate visible on the screen while you are working
in DRAW.    If you're working full-screen, make ClipMate float on top, and iconify it.    Or use a hotkey to 
call it to the top.    The idea is that whenever you copy data with DRAW, just click on ClipMate.    DRAW 
then loses focus, which forces the clipboard update.    ClipMate will then get the data. 



Transient Data
Another trick that applications sometimes play with the clipboard is to provide TRANSIENT data, which 
isn't really data at all.    The most common form of transient data is the OWNER DISPLAY format.    When 
viewed in the clipboard viewer that comes with Windows, the Owner Display format seems to accurately 
represent the data that was copied.    The fonts are the right size, the pictures look great, and it seems to 
take no time at all to copy.    In reality, the data is not really there at all.    The host application is actually 
drawing the data in the window of the clipboard viewer.    This format is absolutely worthless to ClipMate, 
and is therefore ignored.



Memory Management with "Load On Demand"
ClipMate employs a sophisticated scheme called Load On Demand to manage memory and resources 
efficiently.    This was made necessary by the additional capability to handle large data types, such as 
Bitmaps and OLE objects.    It is not unusual for bitmaps to occupy several hundred Kilobytes of memory.  
OLE objects, and private data formats such as RTF, can easily exceed 1 megabyte in size.    Early 
prototypes of ClipMate v2.0 illustrated the resource constraints that the new capabilities imposed.    Given 
the fact that many ClipMate users like to store 25, 50, even hundreds of Clip Items, it was decided that 
ClipMate should only load data that was currently in use.    Once data has been saved to disk, it should 
stay there until needed.    So a Load On Demand feature was implemented for any text item over 1k in 
size, and any other format, no matter what size.    

The Catch: Until a clip item has been saved at least once, it must be kept in main memory, and is not a 
candidate for offloading.    They will accumulate in memory until you save the file.    This will not normally 
create a problem, unless you are working heavily with large data items, such as large bitmaps, RTF, or 
OLE objects.    For example, if you are capturing full-size screen shots of 800x600 pixels, you won't want 
to capture more than 4 or 5 before saving the file.    If you are working with small bitmaps, such as 
100x100 pixels, you can probably do as many as you'd like.    

Related Topics:
The DATA Directory:



The DATA Directory: 
ClipMate maintains a DATA directory beneath its home directory, to store all data files.    There is not a 
direct correlation between the number of Clip Items and the number of files.    If you only use small text 
items, then there will only be the .CLM file (the main ClipMate data file).    If you use complex clip items, 
with several formats, there can be multiple files per clip item.    If you keep lots of clip items, there may be 
quite a few files here.    You'll find the following file types:

.AUX Private formats, RTF, OLE objects, and large text items.    Prefixed with serial 
number of clip item.

.BAK Backup of the .CLM file.    If you have a disaster, you can use this to recover 
to the last successful save.

.BMP Bitmaps.    Prefixed with a serial number.    If the serial number begins with a 
"t", then they are thumbnail bitmaps.

.CLM The main ClipMate data file.    It holds text items smaller than 1K, and has 
pointers to other files for the other data types.

.WMF Pictures.    Prefixed with serial number of clip item.

Note that the filenames of the .AUX, .BMP, and .WMF files will contain the serial number of the 
corresponding clip item.    See: Fields.



Obtaining Current Version Of ClipMate
CompuServe
Internet
America Online (AOL)
Thornton Software BBS



CompuServe
ClipMate exists on CompuServe in several forums.    Some of the ones that we upload directly to are:

WINSHARE (Microsoft Windows Shareware)
Look for CLIPMT.ZIP in lib 6, or wherever they may have put it.

Keyword: CLIPMATE

WINUSER (WUGNET Forum)
Look for CLIPMT.ZIP across all libraries.    ClipMate is involved in some of their projects, 
so they may move it around.    We therefore, don't want to specify a library here.

Keyword: CLIPMATE

UKSHARE (UK Shareware Forum)
Keyword: CLIPMATE



Internet
We are trying to expand our Internet presence.    Ultimately, we hope to have a direct upload site, with 
anonymous FTP capability.    So far, we don't.    So for now, try the following FTP site:

ftp.cica.indiana.edu



America Online (AOL)
Search for keyword: CLIPMATE

AOL is likely to have several "hits", so be sure to read the description before downloading, to get the most
recent.



Thornton Software BBS
We expect to have a BBS operational by October 1, 1994 for downloading ClipMate.    Consult 
CLMREAD.TXT, for up-to-date information on how to call our BBS, which may have been added since 
this manual was printed.



Contacting Thornton Software
You can reach us at any of the following:

CompuServe: (70743,2546)
Internet: 70743.2546@compuserve.com
Phone: (716) 227-6505
FAX (24 hrs): (716) 227-1145  
Mail: Thornton Software Solutions

PO Box 26263
Rochester, NY  14626
USA



Support Policy
Registered users of ClipMate are entitled to support for 90 days from the receipt of the registered copy.    
If you have problems using ClipMate, we are here to help you.    

Please provide a description of the problem, as well as a description of the hardware and software that 
you're using.

If we can't resolve your problem to our mutual satisfaction, we will refund your money, as long as the 
problem is brought to our attention within the 90 day window.

To Contact Thornton Software:
See: Contacting Thornton Software.



ASP
Thornton Software Solutions is a member of the Association of Shareware Professionals.    The ASP is an 
association for shareware authors and vendors with the general goals of educating shareware authors 
and distributors and the public, setting standards, sharing resources and information among members. 
Membership is open to programmers who are authors of at least one "nontrivial" product which is 
currently marketed and supported as shareware, who agree to abide by standards adopted by the 
association, and whose membership, in the judgment of the Membership Committee, will not be 
detrimental to the goals or reputation of the ASP.    Also, Associate Membership is open to Vendors and 
Bulletin Board operators. 

Whenever you see the ASP logo, or the ASP initials, you are assured that the associated product will be 
fully-functional, and of high quality.    

Related Topics:
OMBUDSMAN



OMBUDSMAN
As an ASP member, we are required to display this statement:
This program is produced by a member of the Association of Shareware Professionals (ASP).    ASP 
wants to make sure that the shareware principle works for you. If you are unable to resolve a shareware-
related problem with an ASP member by contacting the member directly, ASP may be able to help. The 
ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products.    Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442 or send a CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536. 



Tips for the Power User
If you have a tip that you would like to share with other users, send it to us.    If we use it in the 
manual and on-line help, we will credit you as the source, and give you a free upgrade!

Related Topics:
ThumbNail Text
Fax Your Signature



ThumbNail Text
You may find it surprisingly easy to use the ThumbNail View to find text items.    The reason for this is that 
you probably have a good idea what certain items look like, whether or not you could quote any given 
word or phrase from it (needed for Word Search).    How many times have you thumbed through a 
magazine, looking for an article?    Often, data that you receive electronically will have a particular visual 
characteristic that you can identify with a glance.    ClipMate's ThumbNail View can help you find those 
items quickly.

Within the ThumbNail Window's Configuration Dialog Box, there is an option for font size.    Use a small 
font, so small that you might not even be able to read the data.    

Place the ThumbNail Window and the Magnification Window side-by-side. 

Don't try to read the thumbnails, look at them.    If you see what you're after, click on it, and then read it in
the Magnification Window.

For more information, see: Visual Selection by ThumbNail, and    ThumbNail Configuration Dialog 
Box.



Fax Your Signature
Fax modems are handy items, especially for sending documents directly from your word processor.    
Unfortunately, you normally can't sign a document that you're sending, like you can with a traditional fax 
machine.    

ClipMate can't solve this problem all by itself, but it can be part of the solution.    Just sign your signature 
several times on a sheet of paper, and use someone else's traditional fax machine to fax your signature to
your fax modem.    Assuming that your fax modem comes with capable viewer software, you can copy 
your signature to ClipMate.    Title the new item as "My Signature", and move it to ClipMate's Safe List.    
Now, you'll always have your signature ready to paste into FAX documents.



Questions & Answers
Can I delete multiple Clip Items?
Why Do I Get Duplicate Items?
Why Do I Receive Data From Both OLE2: and WinWord?
Why do I lose the formatting of text?
When copying bitmaps, why does the ClipMate window flash?
Why can't I paste table cells back into a table (Word for Windows)?



Can I delete multiple Clip Items?
Certainly!    User the Multiple Selection Dialog Box to select all of the items that you want to delete, then 
press the Delete button.    Save the file, and they're gone for good.

Also, you can use the new Delete All function, found under the Edit | Delete menu.    



Why Do I Get Duplicate Items?
Sometimes when you close an application, you'll get a duplicate of the last item copied.    This is because 
the application wants to eliminate any "garbage" data, usually as a result of Delayed Rendering or other 
clipboard tricks.    Some applications will ask you if you want to preserve the clipboard, this is really the 
same thing.    In either case, the clipboard will be updated, and ClipMate will be triggered, thus causing 
the duplicate.    

If you're using an OLE2-compliant application, such as Microsoft Word 6.0, you'll notice that the first item 
will have OLE2 as the source application, and the duplicate will be from WinWord.    Likewise with other 
OLE2 apps, such as EXCEL 5.0.    This is because the cleanup isn't done through OLE2, it is done directly
by the application.    You can use this to your advantage, as you can use the Application Profile to avoid 
the duplicate.    Simply edit the Application Profile for the main application to ignore all formats (no formats
checked) for only the main application, such as WINWORD.    All of the data that you want will come in as 
OLE2, and ClipMate will ignore the duplicate.



Why Do I Receive Data From Both OLE2: and WinWord?
This happens when you close an OLE2-compliant application.    See the answer to: Why Do I Get 
Duplicate Items?.



Why do I lose the formatting of text?
You are probably filtering-out the format that your application needs, in order to properly format the data.   
By default, ClipMate will accept TEXT and BITMAP, but will ignore everything else.    It sounds like you 
need to develop a good filter, to be used with your application.

For more information, see: Application Profile.



When copying bitmaps, why does the ClipMate window flash?
This is necessary in order to properly adjust the palette, when copying bitmaps.



Why can't I paste table cells back into a table (Word for Windows)? 
This is an example of where some applications, like Microsoft's Word for Windows, use local data when 
copy & pasting.    You can get table cells into ClipMate through the RTF format, but then WinWord thinks 
you're trying to paste one table into another, which is illegal.    When WinWord is working with local Cut & 
Pastes, it doesn't use the data on the clipboard.



Glossary of Terms
Active List
Application Profile
Archived
Clip Item
Clip Item Lists
Clipboard
Delayed Rendering
Filter
Glue
Layout 
Title
Transient Formats



Active List
Whichever of the two Clip Item Lists is currently shown in the Clip Item Selection List Box is the Active 
List.    Its corresponding button will appear to be depressed.    The button representing the other list will be 
sticking up, ready to be pushed.    The lists are mutually exclusive, as only one can be active.    See:

    Activate Recyclable List  .



Application Profile
The facility for reducing the amount of unwanted clipboard data that is collected by ClipMate, formerly 
known as FILTER.    See: Application Profile.



Archived
BBS and Disk vendors often compress and group files together to save space, and keep all of the 
distribution files together.    If the file extension is .EXE, then it is a self-extracting archive.    Just execute it,
and it will unpack itself.    If the extension is .ZIP, then you will need PKUNZIP version 2.04G or later to 
decompress.    



Clip Item
When any application places text on the Clipboard, ClipMate makes a copy for itself.    This copy of the 
clipboard contents is considered to be a Clip Item, and is stored in a Clip Item List. 

A Clip Item will have a Clip Item Title, that is initially constructed from the first 50 characters of the clip 
item.    You may edit this title in the Magnification Window, or by selecting Edit Title from the EDIT menu.

Clip Items are dynamically sized upon creation.    They will typically consume a byte of memory for each 
character in the text, plus 50 characters for the title, and a few extra bytes to keep track of everything.

You can edit the Clip Item in the Magnification Window.    

New Clip Items will be placed on one of the Clip Item Lists, depending upon which list is the Active List, 
and the option chosen in the CONFIG screen.    



Clip Item Lists
Clip Items are stored in Clip Item Lists as they are pasted from the Clipboard.    ClipMate supports two 
Clip Item Lists:

Recyclable List:    Maintains a user-defined number of Clip Items.    New Clip Items are at the top of 
the list, and work their way down as still newer items are added.    When the number of Clip Items 
in the list exceeds the user-specified limit, clip items are deleted from the list, thus freeing up 
space in the system.    Since the space is re-usable, the list is known as the Recyclable List.

Safe List:    Stores as many Clip Items as you would ever want to keep.    Like the Recyclable List, 
new Clip Items enter at the top of the list, and work their way down as still newer items are added.
But YOU are responsible for deleting obsolete clip items.    This is a handy way to keep track of 
"Boiler-Plate" items, such as letter templates, return-addresses, or even often-used chunks of 
code, if you happen to be a programmer.

New Clip Items will be placed on one of the Clip Item Lists, depending upon which list is the Active List, 
and the option chosen in the Config screen.    



Clipboard
The Windows clipboard acts as a repository for data in a variety of formats.    Applications can place data 
into the Clipboard, through Copying or Cutting.    Applications can retrieve data from the Clipboard by 
Pasting.    

In actuality, there is no Clipboard program.    At least not in the sense that you could point to a particular 
program, and declare it to be the clipboard.    The Clipboard Utility that comes with Windows is not the 
Clipboard, it is just a utility that can be used to display or delete the contents of the Clipboard.    It does not
have to be open, or even on your hard disk in order to perform Clipboard functions.    In real terms, the 
Windows Clipboard is set of Windows functions that programs use to share data.

The Clipboard can be used to hold a variety of formats, usually simultaneously.    Some common formats 
are BITMAP, Symbolic Link, TIFF, etc.    

This definition is partly based upon the definition of the Clipboard in Tom Swan's Turbo Pascal for 
Windows 3.0 Programming.



Delayed Rendering
A clipboard technique where the host application will "advertise" clipboard formats, without actually 
providing the data.    When another application requests the data, Windows instructs the host application 
to provide the data to the clipboard.    This makes the initial copy seem fast, since no real work is done.    
This is why you need to be conservative when designing filters - you don't want to wait forever to get your 
data!    See: Unfortunate Clipboard Tricks.



Filter
See: Application Profile



Glue

Append or concatenate two or more text items together, forming a larger item.    See:            Glue   
Text.



Layout 
ClipMate gives you the option of displaying all of its graphical controls, along with the Menu (Full Layout), 
or just showing a some of the graphical controls, with no Menu (Brief Layout).    See User Preference 
Dialog Box    for details on how to change the Layout.



Title
Clip Items have titles that describe the data.    If there is a TEXT format present, then the first 50 
characters are used to create the title.    Otherwise, the title is a combination of the name of the app that 
created the data, the first data format encountered, and the serial number.    If multiple formats are 
encountered,    then a (+) follows the format name, to let you know that multiple formats exist. For 
example: PBRUSH: BITMAP(+): 5537    indicates an item from PBRUSH (Paintbrush), which has a 
bitmap, and at least one other format, and is serial number 5537.    

You may change the title of any item:    See: Edit Menu.    



Transient Formats
Data items that depend on the originating application for their existence. See: Unfortunate Clipboard 
Tricks.




